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Manual Notes 
 
 
VDR-100G2S Reference 
Please note that while this manual references the VDR-100G2, it is also applicable to the 
Simplified Voyage Data Recorder (VDR-100G2S) unless otherwise stated.  The VDR-100G2S 
has many similar components to the VDR-100G2, with the following differences: 
 

 The Video Module is only required if the vessel’s radar has an available COTS 
(commercial off-the-shelf) interface. Therefore, the recording of video data may not be 
applicable in some VDR-100G2S installations. 

 The VDR-100G2S has an accompanying Simplified FRM (SFRM) capsule. 
 
 
Software Reference 
Software procedures in this manual are based upon a PC running a Windows XP operating 
system. There may be minor differences depending on the operating system and configuration in 
use on the Client PC. 
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1 Introduction 
 
 
The VDR-100G2/G2S is designed to collect and maintain a secure, retrievable record of marine 
vessel information. This information is related to the position, movement, physical status, and 
command & control of the vessel.  It maintains a continuous record of the most recent 24 hours of 
activity in the Data Processing Unit (DPU).  This is referred to as the Current Data Set. The 
current data set is not affected by any method of copying, backing up or downloading data.   
 
In addition to the current data, the VDR-100G2 offers 4 methods of storing copies of the data.  
These are:  
 
1. The Data Processing Unit (DPU) contains an internal hard drive capable of retaining 

multiple copies of a 24 hour data set.  Emergency Backup of data initiated at the Operation & 
Alarm Unit (OAU) creates Secured Data directories on this drive named according to the date 
and time of backup.  These data backups are referred to as Secured Data Sets.  Secured 
Data may be copied to a download PC via Ethernet LAN connection using Rutter 
Technologies proprietary download software.  Refer to Section 2 – Client PC Download – 
Retrieval Method No 1 for instructions on retrieving data from this internal hard drive. 

 
2. Multiple data sets can be stored to the Rutter USB Memory Stick.  Current data or secured 

data sets copied to the Memory Stick can be manually initiated via the OAU.  Refer to Section 
3 – RSM - USB Memory Stick – Retrieval Method No 2 for instructions on downloading data 
to and retrieving data from the Memory Stick. 

 
3. Multiple data sets can be stored to the optional Remote Storage Module (RSM), if 

connected.  The VDR can be enabled to automatically create an extended archive of data to 
the Remote Storage Module (RSM).  Refer to Section 3 – RSM - USB Memory Stick – 
Retrieval Method No 2 for instructions on downloading data to and retrieving data from the 
RSM. 

 
4. The third method of storage is the Final Recording Medium (FRM) or capsule.  This IMO 

required data storage method should only be attempted when the above-listed methods 
(1) and (2) are not available (i.e., in a situation where the VDR-100G2 is no longer 
functioning due to a major incident.)  Refer to Section 4 – FRM/SFRM Download – Retrieval 
Method No 3 for instructions on retrieving data from the FRM. 

 
 
Once the data has been copied, it may be necessary to contact the ship’s owner / operator or 
Rutter Technologies Inc. to obtain download and playback software or information necessary for 
viewing the data.  Contact information is available in Appendix C of this document.  The name 
and IMO number of the vessel involved will be required in order to provide appropriate files and 
information. 
  
Should the FRM need to be recovered after an incident, dependant upon the severity of the 
damage incurred by the capsule, it may be necessary to contact its manufacturer in order to 
reconstruct and/or refurbish the unit before it is possible to download the data from the capsule. 
(Refer to Section 4 – FRM/SFRM Download). 
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Note! The configuration file (config.txt), used to correctly interpret playback data, is 
contained in the root directory of all data sets and in the FRM capsule memory. 
Therefore, the vessel owner only needs to provide the configuration file when the 
data has been received on a storage medium other than the RSM and/or FRM. 

 
 
 
The IMO Guidelines on Voyage Data Recorder (VDR) Ownership and Recovery white paper is 
available in Appendix D of this document. 
 
IMPORTANT!  While this manual references the VDR-100G2, it is also applicable to the 
Simplified Voyage Data Recorder (VDR-100G2S) unless otherwise stated.
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2 Client PC Download – Retrieval Method No 1 
 
 
The Client PC Download has been designed to allow a user a convenient method of downloading 
data from the VDR-100G2 for immediate playback or the storage of downloaded data on a 
separate recordable medium. 
 
The Client PC is connected to the DMM via an Ethernet connection and may download data at 
any time during normal VDR-100G2 operation without interrupting the system’s recording 
process. In order to remove the data from the vessel, the client PC must be equipped with a 
recordable medium (i.e., a writeable Compact Disc (CD) drive, etc.). It is also possible to use a 
laptop as the client PC, alleviating the need for a recordable device to remove the data from the 
vessel. 
 
Please note a typical data set is too large to be recorded to a single CD and will need to be split 
into shorter segments, occupying several discs, if it is to be removed from the client PC via a CD. 
 
A Client PC should, as a minimum, include: 
 

 Pentium III or higher processor 
 256 MB of memory 
 SVGA Video port and monitor (it is recommended that the monitor be 15” or  

larger and supports a non-scrollable resolution of 1024x768 or greater) 
 Audio hardware with PC speakers or headphones 
 100 Base-TX Ethernet Interface 
 USB 2.0 Port 
 Serial data port (if external ECDIS display support is required) 
 16X DVD-R/DVD-RW drive 
 80 GB or larger internal Hard Disk Drive 
 USB, AT or PS/2 mouse and keyboard 
 Power Supply: Dual Input Voltage: 115V at 60 Hz; or 220V at 50 Hz 
 English O/S Edition: Windows 2000 or Windows XP (recommended). 

 
 
 

Note! If the Client PC is being installed on the bridge of the vessel, it must be IEC 
60945 certified. 

 
 
 
In order to review downloaded data upon playback, it will be necessary to contact the vessel 
owner with vessel specific information (i.e., vessel name and IMO number). Upon receipt of this 
information the vessel owner will be able to provide the necessary files and software for proper 
data interpretation. If a vessel owner is unable to provide the required files, it will be necessary to 
contact Rutter Technologies Inc. (contact information is available in Appendix C of this 
document).
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2.1 Installation of Download Software on Client PC 
There are two (2) steps necessary to install the Download application onto the client PC: 
 

1. Copy the Download application (VDR_Download.exe) from the supplied media to the 
desktop of the download computer, or if an install file is supplied, double-click the “Install 
VDR Download.exe” file. 

2. Configure the download computer as a ‘Client’ for the ‘Download Application’ to connect 
to the VDR-100G2 and retrieve the recorded data. To do this, the download PC must be 
in the same IP segment as the download port on the VDR. The VDR’s download port 
occupies IP address 200.200.200.200. The client PC must be in the same range, with 
the last segment different than the VDR (as shown below.) To change the IP segment: 

a) Open the Control Panel via the Start menu. 
b) Double-click the Network Connections icon. 
c) Right-click on the Local Area Connection icon and select Properties from the 

pop-up menu. 
d) In the Local Area Connection Properties window, highlight “Internet Protocol 

(TCP/IP)” and click the “Properties” button located directly below the available 
options. 

e) In the subsequent Internet Protocol (TCP/IP) Properties window, select the “Use 
the following IP address” radio button and enter 200.200.200.2 (the last number 
can be any number from 2 to 254, except 200.) 

f) Click the “OK” button in the Internet Protocol (TCP/IP) Properties and the Local 
Area Connection Properties.  

 

 
Figure 2-1 - Establishing TCP/IP Address 
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2.2 Connecting to the VDR 
To connect the Client PC to the VDR, complete the following steps: 
 

1. Locate the VDR Data Port, a RJ45 wall jack, mounted on the bridge. 
 

 
Figure 2-2 - VDR Data Port 

 
2. Connect the Client PC to the VDR Data Port via a straight-through Ethernet cable. 

 
 

Note! Ensure the time setting on the Client PC is set to GMT (Greenwich Mean 
Time) and the daylight savings time setting is disabled. To change these settings, 
double-click the clock in bottom right corner of the Windows desktop, select the 
‘Time Zone’ tab, select “(GMT) Greenwich Mean Time” from the time zone drop-
down menu and ensure the “Automatically adjust clock for daylight savings 
changes” checkbox is not checked. 

 
 
 

2.3 Starting the Download Process 
Start the download utility by double-clicking the download.exe icon located on the Windows 
desktop. See Figure 2.3 - Download Software Main Screen for an example of the download utility. 
 

 
Figure 2-3 - Download Software Main Screen 
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2.4 Download Current Data Set 
Complete the following steps to begin the download of the current data set: 
 

1. Select ‘Start download’ from the ‘Download Controls’ menu. 
 

 
Figure 2-4 - Download Controls Menu 

 
 

2. Enter a password when prompted. 
3. Once prompted with the ‘Download Settings’ window (see Figure 2.5 - Download 

Settings Window), choose from the following available settings: 
 ‘Download complete data set’. 
 ‘Download partial data set’ – once this option has been chosen, ‘Start’ and ‘Stop’ 

times become available. Using the appropriate slide-bar, set the time frame that 
will begin and end the downloaded data set. 

 ‘Normal data set’. 
 ‘Extended NMEA data set’ – this option allows for the download of the extended 

NMEA data set only. 
 

 
Figure 2-5 - Download Settings Window 

 
 

4. Confirm that the stated download destination is correct. If it is not, press the ‘Change 
Destination’ button, select the correct destination from the file window, and press ‘OK’. 

5. Press the ‘Start Download’ button. 
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6. Confirm all settings are correct in the confirmation window and press ‘OK’ (if they are 
not, press ’Cancel’ and make the appropriate changes in the ‘Download Settings’ 
window). 

 
 

 
Figure 2-6 - Sample Download Directory 

 
 
Once a download is complete, “MainAudio”, “MainNMEA”, and “MainVideo” folders are visible.  
The vdrparams.ini and vdr-cfg.txt files are also downloaded and saved to the specified download 
directory.  See Figure 2.6 - Sample Download Directory for an example of a typical download 
directory. 
 
 

2.5 Download Secured Data Set 
Complete the following steps to download one (1) of multiple secured data sets from the DMM’s 
internal hard drive: 
 

1. Select ‘Download Secured Dataset’ from the ‘Download Controls’ menu. 
2. A download progress window will appear indicating that the application is receiving 

information from the DMM. 
3. In the subsequent ‘Download Secured Datasets’ window, all available secured datasets 

will be visible. Each dataset shows the date it was initially secured, file size, and start and 
end time. 

 

 
Figure 2-7 - Download Secured Datasets 

 
 

4. Select the appropriate dataset from the list. 
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5. To download a complete dataset, choose the “Download complete data set” radio button 
under ‘Download duration’. To download a partial dataset, choose “Download partial data 
set”. 

6. If choosing to download a partial dataset, a window will appear from which the time range 
to be downloaded must be chosen. The associated scroll bar is used to select a start 
and/or end time (the exact time may also be entered directly in to the time fields.) 

 

 
Figure 2-8 - Partial Download Window 

 
 

7. To choose a directory to which the datasets will be downloaded, other than the one listed 
under ‘Destination’, press the “Change Destination” button and follow standard Windows 
procedure for selecting a desired directory. 

8. Once the duration and destination are correct, press ‘Start Download’. 
9. Enter a password and press ‘OK’. 
10. A “Download Settings” dialog will appear providing confirmation information for the 

dataset to be downloaded. If all information is correct, press ‘OK’ to begin the download. 
 

 
Figure 2-9 - Confirm Download Settings 
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2.6 Extended NMEA Download 
The Extended NMEA data set is a VDR-100G2 option, which supports the recording of up to 185 
days of NMEA data to the DMM. When an extended NMEA download occurs, no video or audio 
data is included in the download. To select the extended NMEA download, check the ‘Extended 
NMEA Download’ located in the ‘Download Settings’ window (see Figure 2.5 - Download Settings 
Window). 
 
 

Important! The extended NMEA data set must be purchased as an option and 
configured on the VDR-100G2 during installation. If the VDR-100G2 is not 
configured for the extended NMEA data set, this option will not function in the 
download software. 

 
 
 

2.7 Complete vs. Partial Download 
A ‘complete’ download is the process of downloading a full 24-hour data set from the DMM. As a 
user may want only a ‘partial’ download, a ‘Download partial data set’ option is available. Select 
either ‘Download complete data set’ or ‘Download partial data set’ in the ‘Download Settings’ 
window (see Figure 2.5 - Download Settings Window) to download the desired data set. 
 
 

 
Figure 2-10 - Completed Download 
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2.8 Error Log and Battery Log 
To download the error log or battery log file, select the applicable item (‘Download Error Log’ or 
‘Download Battery Log’) from the ‘Download Controls’ menu.  The system will prompt the user to 
select a location to save the log file. 
 
 

2.9 Disconnecting from the VDR 
To disconnect, simply choose ‘Exit’ from the ‘File’ menu. 
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3 RSM - USB Memory Stick – Retrieval Method No 2 
 
 
The primary means of removing data recorded by the VDR-100G2 is via the USB Memory Stick 
(version 4.05.00 of the vdr_record.exe application and later).  Each VDR from Serial No. 
20107020850 forward includes a USB Memory Stick.  For units built prior to this time, the primary 
means of removing data is via the RSM.  Refer to Table 3.1 - Data Download: USB Memory Stick 
vs. RSM below for a comparison of versions for copying data. 
 
There are no changes in OAU functionality between these units and versions: 
 

 Where a unit is fitted with a USB Memory Stick and version 4.05.00 of the software, 
data copied using the RSM menu will be copied to the USB Memory Stick.  Where a 
unit has no USB Memory Stick, data is copied to the RSM (if fitted).  

 A VDR with a USB Memory Stick may also have an optional Remote Storage Module 
(RSM) for the purposes of automatic archiving.   

 
Unlike the FRM, which contains only data required by IMO regulations, the USB Memory Stick 
and/or RSM, dependant upon customer requirements, may contain a much larger and highly 
detailed data set.  
 
For units without a USB drive, read this section to understand that the RSM will perform the same 
data copying functionality without need for software or hardware changes. 
 

Comparison of VDR-100G2 Units with USB Memory Stick vs. RSM 

VDR Fitted with Data Copy Destination (when using OAU) Auto Archive 

USB Memory Stick Only USB Memory Stick RSM 

RSM Only RSM RSM 

Both RSM & USB Memory Stick USB Memory Stick RSM 

Table 3.1 - Data Download: USB Memory Stick vs. RSM 

 
 
 

Important! The configuration (Vdr-cfg.txt) and parameters (vdrparams.ini) files, 
which may be used to correctly interpret playback information, are stored and 
located in the root directory of the removable drive. 

 
 
 
 
A portable copy of the recorded data can be obtained by copying data from the DMM internal 
hard drive to the USB Memory Stick or RSM.  Copying data to the USB Memory Stick (or RSM) 
does not affect the normal recording operation of the VDR-100G2. 
 
The OAU is used to initiate copying of data to the USB Memory Stick (or RSM) for removal and 
analysis purposes. 
 
To playback the data from the RSM/USB Memory Stick, a PC will require the following: 
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 The minimum requirements for a PC outlined in Section 2 - Client PC Download – 

Retrieval Method No 1. 
 Rutter Technologies’ playback software. 

 
 
 

Important!  Downloading a secure data set to the USB Memory Stick is done using 
the same procedure as downloading to the RSM (described below).  If a system 
has both an RSM and USB Memory Stick connected at the same time, the 
download instructions below will only download data to the USB Memory Stick.  
The RSM will continue in auto-archiving mode only. 

 
 
 
 

3.1 Copying Data to RSM/USB Memory Stick 
To retrieve data using the OAU, it is necessary to ensure the USB Memory Stick/RSM is 
connected and recognized by the G2 system. Complete the following steps: 
 

1. If not already connected, insert the USB Memory Stick into the available USB port or 
attach the Ethernet and power cable from the RSM to the DPU (or connect the USB 
Memory Stick to the DMM). 

 
2. Press the “RSM” button on the OAU menu pad. 

 
3. At the main menu screen of the OAU, two (2) options are displayed: 

 
 “Copy Data” 
 “RSM Archiving” 

 
 

Note! The RSM cannot be simultaneously connected via Ethernet to the VDR 
while connected to the Client PC via a USB connection. 
 

 
4. Ensure the “Copy Data” option is highlighted (blinking cursor is adjacent to the option.) 

Once highlighted, press the “Enter” button on the OAU menu pad. 
 

5. Three (3) options are now displayed: 
 

 “Copy Current Data”: allows a user to retrieve a full 24-hour data set. See 
Section 3.1.1 - Copy Current Data. 

 “Copy Secured Data”: allows a user to retrieve specific segments that have been 
previously secured and may range in length of time. See Section 3.1.2 - Copying 
Secured Data. 

 “Copy Extended NMEA”: allows a user to retrieve extended NMEA data. See 
Section 3.1.3 - Copying Extended NMEA Data. 
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Important! If Auto Archiving is enabled, do not physically disconnect the Remote 
Storage Module before disconnecting it from the system via the OAU. See Section 
3.1.4 - Disconnecting the RSM for instructions on disconnecting via the OAU. 
 
It is also recommended to power off the unit prior to physically disconnecting it. 
 
Once the RSM is physically disconnected from the DMM, it will take approximately 
one (1) minute for the system to recognize this disconnect. DO NOT reconnect the 
RSM before this one (1) minute wait period has elapsed, as it will not be 
recognized by the system. If the RSM is accidentally reconnected before the one 
(1) minute wait period has elapsed, physically disconnect the RSM from the DMM 
and wait one (1) minute before physically reconnecting. Once the RSM is 
physically connected, connect to the DMM software via the OAU. 

 
 
 

3.1.1 Copy Current Data 
To copy the current data from the internal drive of the DMM to the USB Memory Stick/RSM, the 
following steps must be completed: 
 

 Press the “RSM” key on the OAU menu pad 
 Highlight ‘Copy Data’ and press ‘Enter’ on the OAU menu pad 
 Highlight ‘Copy Current Data’ and press ‘Enter’ on the OAU menu pad 

 
The full data set residing on the internal drive of the DMM will be copied to the USB Memory 
Stick/RSM. As the data is copied, the OAU display may indicate the percentage of data that has 
been copied dependant upon the size of the download. To cancel the download, simply press 
“Cancel” on the OAU menu pad. 
 
 

3.1.2 Copying Secured Data 
Data sets can be secured on the internal drive of the DMM at any time via the OAU menu pad.  If 
sufficient space does not exist on the internal drive to secure a data set, the oldest secure data 
set will be automatically deleted.  Therefore, it is convenient to copy any one of these secure data 
sets to the USB Memory Stick/RSM.  
 
Secured data sets can be copied to the USB Memory Stick/RSM for longer term storage or for 
portability to shore side facilities.  To copy a secured data set to the USB Memory Stick/RSM, the 
following steps must be completed: 
 

 Press the “RSM” key on the OAU menu pad. 
 Highlight ‘Copy Data’ and press ‘Enter’ on the OAU menu pad. 
 Highlight ‘Copy Secured Data’ and press ‘Enter’ on the OAU menu pad. 
 All available secured data sets (displayed in yyyy-mm-dd-hr-mt format) will become 

visible. Secured data sets appear two (2) per screen. If more than two (2) secured data 
sets exist, press the “Prev” and/or “Next” buttons on the menu pad to scroll through all 
sets available. The total number of data set screens available is shown on the screen (for 
example, “Page 3/21”). 

 Once the desired data set is highlighted, press the “Enter” key on the OAU keypad. Press 
the “Enter” key again to confirm the download. 
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The selected secured data set will be copied to the USB Memory Stick/RSM.  As the data is 
copied, the OAU display will indicate the percentage of data that has been copied. To cancel the 
download, simply press “Cancel” on the OAU menu pad. 
 

3.1.3 Copying Extended NMEA Data 
The VDR100G2 can optionally store up to 185 days of NMEA data. This data can then be copied 
to the USB Memory Stick/RSM by the following steps: 
 

1. Press the “RSM” key on the OAU menu pad. 
2. Highlight ‘Copy Data’ and press ‘Enter’ on the OAU menu pad. 
3. Highlight ‘Copy Extended NMEA Data’ and press ‘Enter’ on the OAU menu pad. 

 
All Extended NMEA data will then be copied to the USB Memory Stick/RSM.  As the data is 
copied, the OAU display will indicate the percentage of data that has been copied. To cancel the 
download, simply press “Cancel” on the OAU menu pad. 
 

3.1.4 Disconnecting the RSM 
When Auto Archiving is enabled, it is important to disconnect via the OAU keypad prior to 
physically disconnecting from the VDR.  To check if Auto Archiving is enabled, press the “RSM” 
key on the OAU keypad; if “RSM Archiving” appears as a menu option, it is enabled. 
 
To disconnect the RSM: 
 

1. Press the “RSM” key on the OAU menu pad. 
2. Press the down (↓) arrow to select the “RSM Archiving” option on the OAU LCD display 

and press the “Enter” key. 
3. Select “Disable Extended Archiving” and press the “Enter” key on the OAU menu pad. 
4. Power off the RSM (switch RSM Power Switch to “Off” position). 
5. Remove all cable connections from the RSM. 

 
 

 

USB Port 
Power Input 

Ethernet Port Power Switch 

Figure 3-1 - Rear View of RSM Unit 

 
 

Important!  Do not disconnect the USB Memory Stick during data transfer.  If data 
is being transferred to the Memory Stick the blue light located on the body of the 
Memory Stick will flash rapidly.  Once data transfer is complete the blue light will 
stay solid. 
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3.2 Connecting Client PC to RSM 
To retrieve data from the RSM using the Client PC, complete the following steps: 
 

1. Physically disconnect the RSM Ethernet cable and connect it to the Client PC using an “A 
to B mini” USB cable. 

2. The RSM will be visible on the Client PC as a connected hard drive.

 
VDR-100G2/G2S Data Recovery Manual  15 
RUT-UM-02-003_Rev1.9 



This page is intentionally blank.

 
VDR-100G2/G2S Data Recovery Manual  16 
RUT-UM-02-003_Rev1.9 



4 FRM/SFRM Download – Retrieval Method No 3 
 
 
Recovery of data from the FRM/SFRM should only be carried out in a situation where an 
incident has rendered the VDR inoperative. Data recovery must be carried out according to the 
manufacturer’s instructions, using proprietary software provided by Rutter Technologies Inc. 
 
The VDR-100G2 can currently accommodate the Rutter FRM (RUT-02447) Fixed Capsule or the 
L3 HVR-01/ 02 Fixed FRM Capsule. The VDR-100G2S can currently accommodate the Rutter 
FRM (RUT-02447) Fixed Capsule, the L3 SVR-01/02, the Jotron Float-Free SFRM Capsule, and 
the Rutter-ACR Float-Free SFRM Capsule. 
 
Once the FRM/SFRM has been recovered, dependant upon the severity of the incident, it may be 
necessary to contact the capsule manufacturer in order to reconstruct and/or refurbish the unit 
before downloading may commence. Contact information for the FRM/SFRM manufacturer 
mentioned above is available in Appendix C – Contact Information. 
 
It will also be necessary to contact Rutter Technologies Inc., providing the vessel name and IMO 
number in order to receive the necessary download, playback, configuration, and partition 
information files (contact information is available in Appendix C of this document).  Appendix A – 
Incident Data Recovery Checklist provides a guideline of steps to be carried out by the incident 
investigation team in the event that they may have to recover a FRM/SFRM unit. 
 
The following procedure should only be attempted by an authorized service technician and is not 
required for day-to-day operations. 

4.1 Damage to Ship and Minor Damage to FRM/SFRM 
The VDR-100G2 is capable of downloading data directly from the FRM/SFRM. Therefore, if the 
VDR-100G2 can communicate with the FRM/SFRM, data can be retrieved using the VDR-100G2 
as the Client PC. 
 
If preferred, or if damage makes VDR-FRM/SFRM communication impossible, the methods 
described in Section 4.2 - No VDR Communications with FRM/SFRM may also be employed to 
retrieve the FRM/SFRM data. 
 

Note! Before downloading from an L3 HVR/SVR capsule, it is essential to have the 
capsule’s partition information. In the case of an incident, please contact Rutter 
Technologies Inc. for further instructions on obtaining the correct partition 
information. 

4.1.1 Downloading FRM/SFRM Data Directly to the VDR-100G2 
In the case where the VDR-100G2 can communicate with the FRM/SFRM, the VDR-100G2 may 
be used to download data directly from the FRM/SFRM. After the data is downloaded, it may then 
be copied off of the VDR-100G2 internal storage drive to a Playback PC. The following steps 
outline the procedure to download data directly to the VDR-100G2. 
 
 

Note! Before downloading directly to the VDR-100G2, it is necessary to stop the 
VDR-100G2 Watchdog Application and the VDR-100G2 Record Application. The 
Investigator must then log out of the MyUser account, and then log in to the VDR-
100G2 as Administrator. Please contact Rutter Technologies Inc. for further 
instructions on obtaining the correct username and password information. 
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4.1.1.1 Downloading Data Using the FRM Download Application 
As Administrator on the VDR-100G2, use the FRM Download Application to download data 
directly from the FRM/SFRM. The following steps outline the procedure to use the FRM 
Download Application the retrieve data from an FRM/SFRM: 
 

Note! This section is not applicable to downloading data from a Jotron Float-Free 
SFRM Capsule connected to VDR-100G2 systems running VDR Record 
Application 4.06.00 and earlier. To download Jotron data recorded using VDR 
Record Application 4.06.00 and earlier directly to the VDR-100G2, refer to Section 
4.1.1.2 Jotron Float-Free SFRM Capsule (pre 4.07.00). 
 

1.  Start the FRM Download Application by clicking “Start”, “All Programs”, “Rutter”, “VDR”, and 
finally “FRM Download”. Alternatively, locate the FRM Download.exe file in the VDR-100G2 
‘C:\VDRApps\’ folder, and double-click to start the application. 

 

 
Figure 4-1 – VDR FRM Download Application 

 
 
2. From the “Download” Menu select “Download Wizard…”. Select the FRM/SFRM type for this 

download session from the list of FRM/SFRMs on the first page of the Download Wizard 
 

 
VDR-100G2/G2S Data Recovery Manual  18 
RUT-UM-02-003_Rev1.9 



 
Figure 4-2 – Download Wizard FRM Setup Page 

 
3. Select “Use default settings to connect to FRM” and click next. 
 

 
Figure 4-3 - Download Wizard FRM Connection Settings Page 

 
4. Select the data types you wish to download (Ensure all are selected). 
 
5. Use the ‘Browse’ button to select a suitable location to extract the contents of the FRM/SFRM 

to. When downloading directly to the VDR-100G2, it is recommended that the data be 
downloaded to the ‘E:\’ drive. This directory is ‘shared’ and is accessible to a Playback PC via 
the download port on the VDR-100G2. Alternatively, data may be copied directly to an 
attached RSM or Download USB Drive. 

 
 

Note! In either case, there must be sufficient free memory space to accommodate 
the entire downloaded data set. This may require up to 4GB of free memory space, 
dependant on the FRM/SFRM being downloaded. 
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Figure 4-4 - Download Wizard Data Management Page 

6. Enter the password to begin the download process. The default password is ‘VDR’ (case 
sensitive). 

 
 

Note! Depending on the FRM/SFRM design, the download process may take 
anywhere from 15 minute up to 4 hours. 

 
 

 
Figure 4-5 – Download in Progress 
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7. When the download has completed successfully, a message will appear in the log window of 
the FRM Download application indicating the download has completed along with the elapsed 
download time and the average speed of the download. 

 

 
Figure 4-6  – Download Complete. 

 
8. Once the download is complete, disconnect from the FRM/SFRM by selecting ‘Exit’ from the 

‘File’ menu. 
 

9. The downloaded data may now be moved to a Playback PC running the Rutter Playback 
software for review. See Section 4.1.1.3 Copying the Downloaded Data to a Playback PC for 
details. 

4.1.1.2 Jotron Float-Free SFRM Capsule (pre 4.07.00) 
This section is applicable to the JoTron Float-Free SFRM Capsule only, to retrieve data recorded 
using VDR-100G2 Record Application versions prior to 4.07.00.  
 
1. From the VDR-100G2 Administrator account, copy the contents of the “X:\” drive to the ‘E:\‘ 

drive on the VDR-100G2. This directory is ‘shared’ and is accessible to a Playback PC via the 
download port on the VDR-100G2. Alternatively, data may be copied directly to an attached 
RSM or Download USB Drive. 

 
2. Check the VDRPARAMS.INI file to ensure the downloaded NMEA data is not compressed.  

The following entry: NetworkHVR-compressNMEA = 1 indicates that the NMEA data is being 
compressed.  NetworkHVR-compressNMEA = 0 indicates that the NMEA data is not being 
compressed. 

 
3. If the NMEA data is compressed, run the decompressNMEA.exe file located in the 

C:\VDRApps folder in order to decompress the data. 
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4. The downloaded data may now be moved to a Playback PC running the Rutter Playback 
software for review. See Section 4.1.1.3 Copying the Downloaded Data to a Playback PC for 
details. 

4.1.1.3 Copying the Downloaded Data to a Playback PC  
With the data now downloaded to the VDR-100G2, it may now be moved to a Playback PC 
running the Rutter Playback Application for review. See Chapter 6 - Playback Software for details 
of installing and using the Rutter Playback software, 

4.1.1.3.1 Copying The Downloaded Data Via Drive Mapping 
If the FRM/SFRM data was downloaded to the VDR-100G2’s ‘E:\’ drive, connect the Playback PC 
to the VDR-100G2’s Download Ethernet port to retrieve the data. The following steps illustrate 
this procedure: 
 
1. The Playback PC must be in the same IP segment as the VDR-100G2’s Download Ethernet 

port. The VDR-100G2’s Download Ethernet port occupies IP address 200.200.200.200. The 
Playback PC must be in the same range, with the last segment different than the VDR-
100G2 (as shown below.) To change the IP segment: 

a) Open the Control Panel via the Start menu. 
b) Double-click the Network Connections icon. 
c) Right-click on the Local Area Connection icon and select Properties from the 

pop-up menu. 
d) In the Local Area Connection Properties window, highlight “Internet Protocol 

(TCP/IP)” and click the “Properties” button located directly below the available 
options. 

e) In the subsequent Internet Protocol (TCP/IP) Properties window, select the “Use 
the following IP address” radio button and enter 200.200.200.2 (the last number 
can be any number from 2 to 254, except 200.) 

f) Click the “OK” button in the Internet Protocol (TCP/IP) Properties and the Local 
Area Connection Properties.  

 

 
Figure 4-7- Establishing TCP/IP Address 

 

2. Locate the VDR Data Port, a RJ45 wall jack, mounted on the bridge. 
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Figure 4-8 - VDR Data Port 

 

 
3. Connect the Playback PC to the VDR Data Port via a straight-through Ethernet cable. 
 
4. Via Windows Explorer, select ‘Tools>Map Network Drive’. Select a drive letter not in use by 

the Playback PC, and enter ‘\\200.200.200.200\Secured Data’ in the ‘Folder’ text box. 
 

 
Figure 4-9 – Mapping the Secured Data Drive 

 
 

5. When prompted, enter ‘MyUser’ for the user name and ‘Rutter’ for the password. Please note 
that these entries are case-sensitive. 
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Figure 4-10 – Enter Password and User name 

 
6. When the Playback PC connects to the ‘Secured Data’ drive on the VDR-100G2, it will 

appear in Windows Explorer. 
 

 
Figure 4-11 – The Mapped Secured Data Drive 

 
7. Select the downloaded data set of interest, and copy it to the Playback PC. 

4.1.1.3.2 Copying the Downloaded Data Via RSM / Download USB Drive 
If the FRM/SFRM data was downloaded to the VDR-100G2’s RSM or Download USB Drive, the 
investigator can copy the data directly to the Playback PC. 
 
Remove the device containing the downloaded data from the VDR-100G2, and connect it to the 
Playback PC. When connected, the downloaded data may be copied off of the device, or the 
Playback software may be used to play back the data directly off of the device. See Sections 
3.1.4 Disconnecting the RSM and 3.2 Connecting Client PC to RSM for details on disconnecting 
the RSM from the VDR-100G2and connecting it to the Playback PC. 

4.1.2 Downloading FRM/SFRM Data Directly to the Playback/Client 
PC 

Even if the VDR-100G2 is capable of downloading data directly from the FRM/SFRM (i.e. there is 
VDR-FRM/SFRM communication), it may be preferred to download the FRM/SFRM data directly 
to the Client/Playback PC. If this is the case, use the methods described in   Section 4.2: No VDR 
Communications with FRM/SFRM to retrieve the FRM/SFRM data. 
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4.2 No VDR Communications with FRM/SFRM 
If the FRM/SFRM is intact but is unable to communicate with the VDR-100G2, it is possible to 
connect a Client/Playback PC to the FRM/SFRM and download the recorded data directly to it. To 
download data directly from the FRM/SFRM to a Client PC, the Client PC must have the 
following: 
 

 A 100 Base-TX Ethernet Interface (RJ45). 
 Rutter Technologies Inc. proprietary FRM Download Application software. 

 
 

Note! The following information is only applicable to the Rutter FRM (RUT-02447) 
Fixed Capsule, the L3 HVR/SVR Fixed FRM/SFRM Capsule and the Rutter-ACR 
Float-Free SFRM Capsule.  For information on connecting to the Jotron Float-Free 
SFRM Capsule, refer to the manufacturer’s technical manual.  

4.2.1 Connecting to a Rutter FRM (RUT-02447) Fixed Capsule or L3 
HVR/SVR Fixed FRM/SFRM Capsule 

 
1. Locate the capsule and its associated FRM Junction Box. 
2. Remove the power and Ethernet cable from the Junction Box. 
3. Connect the power cable to a 24V power source. 
4. Using the information in Table 4.1 - Wiring Diagram for 10BaseT Crossover Cable  below, 

adjust the wiring of the existing Ethernet cable to make it a crossover cable and add a RJ45 
connector. 

5. Connect the RJ45 connector to the Client PC. 

 
Figure 4-12 - RJ45 Connector 

 
Pinout Striped Colour Solid Colour 

Pin 1 (TD+) ----------------------------------------------------------------- (RD+) Pin 3 White/Orange Green 

Pin 2 (TD+) ------------------------------------------------------------------ (RD-) Pin 6 Orange Yellow 

Pin 3 (TD+) ----------------------------------------------------------------- (TD+) Pin 1 White/Green Blue 

Pin 4 ------------------------ (Not used by 10BaseT) -------------------------- Pin 4 Blue Red 

Pin 5 ------------------------ (Not used by 10BaseT) -------------------------- Pin 5 White/Blue Black 

Pin 6 (RD-) ------------------------------------------------------------------ (TD-) Pin 2 Green Orange 

Pin 7 ------------------------ (Not used by 10BaseT) -------------------------- Pin 7 White/Brown Brown 

Pin 8 ------------------------ (Not used by 10BaseT) -------------------------- Pin 8 Brown Grey 

Table 4.1 - Wiring Diagram for 10BaseT Crossover Cable 

 
NOTE! It is important to remember that Pins 1 & 2 are a twisted pair and Pins 3 & 
6 are a twisted pair. 
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4.2.2 Connecting to a Rutter-ACR Float-Free SFRM Capsule 
The Rutter-ACR Float-Free SFRM Capsule uses PoE technology to provide power and data 
connectivity between it and the VDR-100G2. The following steps illustrate how to connect the 
Rutter-ACR Float-Free SFRM Capsule directly to a Client PC: 
1. Locate the Rutter-ACR Float-Free SFRM Capsule and its associated PoE Power Injector 

(PS-100). The PoE Power Injector is located inside the DPU. 
2. Remove the power and Ethernet cable between PoE Power Injector and the DMM and DPU 

power terminal block, respectively. 
3. Connect the power cable to a 24V power source. 
4. Connect the RJ45 connector to the Client PC. The Ethernet connection may be made with 

the existing Ethernet cable. It is not necessary to change either of the Ethernet cables from 
straight-through to cross-over or from cross-over to straight-through. 

 
Figure 4-13 – Client PC to Rutter-ACR Float-Free SFRM Capsule Connectivity 

4.2.3 Connecting to a Jotron Float-Free SFRM Capsule 
For information on connecting to the Jotron Float-Free SFRM Capsule to a Client PC, refer to the 
manufacturer’s technical manual. 

4.2.4 Installing the FRM Download Application 
Prior to downloading data from the FRM/SFRM directly to the Client PC, the FRM Download 
Application must be installed on the Client PC. The installation of the FRM Download Application 
is mostly automated and requires little user interaction. The install is performed via a self-
extracting executable file and is installed to C:\Program Files\Rutter\FRM Download\ by default. 
There will be a shortcut added to the Start menu upon completion of the installation. 
 
To complete the installation of the FRM Download Application, complete the steps listed below: 
 
1. Copy the FRM Download Application installer (FRM Download Setup.exe) from the VDR 

Data Recovery CD supplied by Rutter Technologies Inc. to the desktop of the Client PC. 
2. Once copied, locate the file entitled ‘FRM Download Setup.exe’ and double-click it. 
 

 
Figure 4-14 – Installation Executable File 
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3.  Read the information on the welcome page of the setup wizard and click ‘next’. 
 

 
Figure 4-15 – Setup Wizard Welcome Page 

4. The ‘Choose Components’ page there will be an option to include or exclude ‘Windows  
Services for Unix’. This option should be checked when using the FRM Download Application 
with a Rutter Fixed Capsule. Otherwise, this option can be unchecked. 

 

 
Figure 4-16 - Setup Wizard Component Selection Page 

  
5. Choose the directory to which the FRM Download Application will be installed and click 

‘Install’ to proceed with the installation. 
 

Note! Due to limitations with the installation process of ‘Windows Services for 
Unix’, this component will be installed to “C:\SFU” by default. 
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Figure 4-17  – Setup Wizard Install Location Page 

 
6. Installation will proceed until the process is completed 
 

 
Figure 4-18 – Installing the Application Files 

 
7. Once the FRM Download Application setup wizard has completed, click ‘Finish’ to complete 

the installation process. 
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Figure 4-19 – Setup Completed 

4.2.5 Copy VDRParams.ini 
Copy the ‘vdrparams.ini’ file to the ‘C:\WINDOWS’ folder from the VDR Data Recovery Software 
CD supplied by Rutter Technologies Inc. 

4.2.6 Setting the Client PC IP Address 
The IP address of the Client PC must be altered to match the IP of the FRM/SFRM (excluding the 
last segment). The FRM/SFRM IP is provided in the vdrparams.ini file.  

1. To change the Client PC’s IP address, open the ‘Control Panel’ > ‘Network and Dial-up 
Connections’ > ‘Local Area Connection’ and click the ‘Properties’ button. 

2. In the subsequent ‘Local Area Connection Properties’ window select ‘Internet Protocol 
(TCP/IP) in the ‘Components checked are used by this connection:’ selection area and 
click the ‘Properties’ button. 

3. In the subsequent ‘Internet Protocol (TCP/IP) Properties’ window, select the ‘Use the 
following IP address’ radio button and enter the appropriate FRM/SFRM IP address in 
the ‘IP Address:’ field. 

4. The last segment will have to be changed to a number between 3 and 255, but cannot 
be the same number as the FRM/SFRM IP address (i.e., if the FRM/SFRM IP address is 
192.168.0.2, the Client PC address may be entered as 192.168.0.3). 
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Figure 4-20 – TCP/IP Configuration 

4.2.7 Downloading Data Using the FRM Download Application 
After installing the FRM Download Application, it can be used to download data directly from the 
FRM/SFRM to the Client PC. The following steps outline the procedure to use the FRM Download 
Application the retrieve data from an FRM/SFRM: 
 

Note! Before downloading from an L3 HVR/SVR Fixed FRM/SFRM, it is essential 
to have the capsule’s partition information. In the case of an incident, please 
contact Rutter Technologies Inc. for further instructions on obtaining the correct 
partition information. 

 
 

Note! This section is not applicable to downloading data from a Jotron Float-Free 
SFRM Capsule connected to VDR-100G2 systems running VDR Record 
Application 4.06.00 and earlier. To download Jotron data recorded using VDR 
Record Application 4.06.00 and earlier directly to the VDR-100G2, refer to Section 
4.2.8 Jotron Float-Free Capsule (pre 4.07.00). 
 

1.  Start the FRM Download Application by clicking “Start”, “All Programs”, “Rutter”, “VDR”, and 
finally “FRM Download”. 

 

 
Figure 4-21 – VDR FRM Download Application 
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2. From the “Download” Menu select “Download Wizard…”. Select the FRM/SFRM type for this 

download session from the list of FRM/SFRMs on the first page of the Download Wizard 
 

 
Figure 4-22 – Download Wizard FRM Setup Page 

3. Select “Use default settings to connect to FRM” and click next. 
 

 
Figure 4-23 – Download Wizard FRM Connection Settings Page 

 
4. Select the data types you wish to download (Ensure all are selected). 
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5. Use the ‘Browse’ button to select a suitable location to extract the contents of the FRM/SFRM 

to. 
 

Note! There must be sufficient free memory space to accommodate the entire 
downloaded data set. This may require up to 4GB of free memory space, dependant 
on the FRM/SFRM being downloaded. 

 
 

 
Figure 4-24  – Download Wizard Data Management Page 

6. Enter the password to begin the download process. The default password is ‘VDR’ (case 
sensitive). 

 
Note! Depending on the FRM/SFRM design, the download process may take 
anywhere from 15 minute up to 4 hours. 
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Figure 4-25 – Download in Progress 

7. When the download has completed successfully, a message will appear in the log window of 
the FRM Download Application indicating the download has completed along with the 
elapsed download time and the average speed of the download. 

 

 
Figure 4-26 – Download Complete 
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8. Once the download is complete, disconnect from the FRM/SFRM by selecting ‘Exit’ from the 

‘File’ menu. 
 
9. The downloaded data may now be reviewed using the Rutter Playback software. 

4.2.8 Jotron Float-Free SFRM Capsule (pre 4.07.00) 
This section is applicable to the Jotron Float-Free SFRM Capsule only, to retrieve data 
recorded to the capsule using VDR-100G2 Record Application versions prior to 4.07.00.   

 
1. Following the manufacturer’s specifications, map the Jotron Float-Free SFRM Capsule to the 

“X:\” drive letter on the Client PC. 
 
2. Copy the contents of the “X:\” drive to the Client PC. 
 
3. Check the VDRPARAMS.INI file to ensure the downloaded NMEA data is not compressed.  

The following entry: NetworkHVR-compressNMEA = 1 indicates that the NMEA data is being 
compressed.  NetworkHVR-compressNMEA = 0 indicates that the NMEA data is not being 
compressed. 

 
4. If the NMEA data is compressed, copy the decompressNMEA.exe file located on the VDR 

Data Recovery CD supplied by Rutter Technologies Inc to the Client PC desktop and run it 
on the downloaded NMEA data. 

 
5. The downloaded data may now be reviewed using the Rutter Playback software. 

4.3 Damage to Ship and Severe Damage to FRM/SFRM 
In the event that the FRM/SFRM has undergone severe mechanical damage, fire, or if the 
memory cable is damaged or destroyed, the module will have to be returned to the 
manufacturer’s facility for repair.  Refer to Appendix C for further information.
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5 Operation & Alarm Unit – Operating Guide 
 
The following section provides a user guide for operating the VDR-100G2/S. All user-level 
operation occurs via the OAU. The OAU provides the ability to secure data as well as offering 
audible alarms that alert the user to potential problems with the unit and/or component 
connections. 
 

 
Figure 5-1 – OAU Menu Pad 

 
 

5.1 Securing Data 
To secure data to the DMM, complete the following steps: 
 

1. Press the “Emrg Backup” button on the OAU menu pad. The following message will 
appear on the OAU’s LCD: 

 
“Perform Emergency Backup of VDR Data” 
“> Enter to Confirm” 

 
2. Press the “Enter” button on the OAU menu pad. The following message will appear: 
 

“Downloading Data” 
“Please Wait…” 

 
3. Allow the download to complete. A progression message may appear (i.e., “20% 

Complete”) dependant upon the size of the download. 
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5.2 Viewing Secured Data 
To view previously secured data sets, complete the following steps: 
 

1. Press the “View Data” button on the OAU menu pad. 
 

2. Secured data sets appear two (2) per screen. If more than two (2) secured data sets 
exist, press the “Prev” and/or “Next” buttons on the menu pad to scroll through all sets 
available. Data sets appear from oldest to newest and are recorded with the following 
time format: yyyy-mm-dd-hr-mt (where yyyy=year, mm=month, dd=day, hr=hour, and 
mt=minute). 

 
 

5.3 Securing Data to the USB Memory Stick / RSM 
For instructions on securing data to the RSM, see Section 3 – RSM - USB Memory Stick – 
Retrieval Method No 2. 
 

5.4 Muting Audible Alarm 
To mute the audible alarm, press the “Mute” key on the OAU menu pad. 
 

5.5 Dimming the Display 
To dim or brighten the LCD display, press the “Dim” key on the OAU menu pad.  
 
There are four (4) LCD brightness levels ranging from off to bright. 
 

5.6 Test Screen 
To obtain the VDR Record software version number or the unique DMM Hardware ID, press the 
“Test” key on the OAU menu pad. 
 
An example of the information provided via the “Tests” menu, is as follows: 
 
**Test Screen** 
Version: 4.02.00 
ID: 55N5SS5S55X21 
 
 
 

Note! It is essential to record the DMM Hardware ID correctly, as an incorrect ID 
could cause a loss of features in various VDR software applications. 

 
 
 
Press the “Cancel” button to return to the main screen. 
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5.7 Alarm Code Description 
Listed below are the alarm codes that may appear on the OAU LCD display: 
 

Alarm Code Description 

System Error Communication with the Record Application has been lost 

Video Error Communication with the Video Module has been lost 

Audio Error Communication with the Audio Module has been lost 

FRM Error Communication with the Final Recording Medium has been lost 

Power Fail Loss of utility power 

PCM Error Communication has been lost with the Power Control Module 

Remote Error Communication has been lost with the Remote Storage Module 

Serial Error Communication has been lost with the NMEA Module 

Mic Error Communication has been lost with one of the microphones 

Disk Error Failure to secure a data set 

GPS Error Failure to record GPS data 

Table 5.1 – Alarm Code Description 

 
Pressing the “Mute” button acknowledges the alarm code and silences the alarm.
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6 Playback Software 
 
The playback module accompanies the base model VDR and is resident on the download client 
PC. Additional playback software is available for use in shore-side offices. This additional 
software is necessary for the playback of data on the RSM or other media once it has been 
removed from the ship and transported to the office environment. 
 
 

Important! The computer on which the Playback application is being installed 
must have its regional and language options adjusted to English. This may be 
done by double clicking the ‘Regional Options’ icon in the Control Panel window 
and selecting ‘English’ from the language drop down list. It is recommended that 
either ‘English (United States)’ or ‘English (Canada)’ is selected. However, any of 
the available English options are acceptable. 

 
 

6.1 Playback Installation – Client/Standalone PC 
The installation of playback software is automated and requires little interaction. The install is 
performed via a self-extracting executable file and is automatically installed to the C:\Program 
Files\Playback directory, with a shortcut placed on the Windows desktop. The install file will 
normally be named “Install VDR Playback.exe”. 
 
To begin the installation, complete the steps listed below: 
 

1. On the installation CD, double click the file entitled ‘Install VDR Playback.exe’. 
 

 
Figure 6-1 – Installation Executable File 

 
 

2. Choose the directory to which the executable will be installed. 
 

 
Figure 6-2 – Choose Installation Directory 

 
 

3. To abort the installation, click the ‘Abort’ button on the ‘Installing…’ message window. 
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Figure 6-3 – Installing Message Window 

 
 

4. The install process will place a shortcut to the playback software on the desktop. 
 
 

6.2 Starting the Playback Application 
To start the playback application, double click the playback icon located on the desktop (as 
mentioned in step 4 of the installation process above). The application will look similar to Figure 
6.4 – Playback Software shown below.   
 
Note that the playback application interprets information provided in the ship’s VDRPlayback.ini 
file therefore the playback interface may contain elements and controls different from what is 
shown below. 
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Figure 6-4 – Playback Software 



6.2.1 Configuration File 
The vessel displayed in the Playback application is automatically configured via the ship’s 
configuration file, which is created by the installation technician during the installation of the VDR. 
The configuration file pertaining to the ship whose data will be used by the Playback application 
must be located in an easily accessed location on the local hard drive of the playback PC. 
 
Upon start-up of the Playback application, the configuration file can be loaded using the File > 
Configure menu item. 
 

 
Figure 6-5 – Configuration File Selection – Menu Item 

 
 
A dialog window will appear allowing the user to select the applicable file. Once the file has been 
selected the Playback application will shut down momentarily and restart automatically. Upon 
restart the chosen configuration file will load automatically. To change the configuration file, select 
the File > Configure menu item, as above, and choose the newly desired file. 
 

 
Figure 6-6 – Restart Warning 

 
 
With the VDR-100G2, the ship’s configuration file will accompany every available data set. When 
a data set is selected the configuration file will be automatically reloaded as necessary. 
 
 

6.3 Choosing Data for Playback 
To select a data set for playback: 
 

1. Choose the ‘Open’ icon located directly underneath the ‘File’ menu 
2. A dialog box will appear. Use the dialog box to locate a folder containing downloaded 

data and select one of the three (3) .vdr files.  Ensure “All Files” is selected in the “Files 
of Type” drop down box. 

3. The .vdr files accompany every download and act as an “index” to the actual data files. 
They are named according to the data items they reference: AudioDir.vdr for audio, 
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NMEADir.vdr for NMEA data and VideoDir.vdr for video data. Selecting any one of these 
three files will open a data set for playback. 

 
 
 

Note! If the download directory does not display three (3) files with extensions of 
“.vdr”, it is possible that the Microsoft operating system is treating them as hidden 
files.  

 
 
 
To ensure that the .vdr files are being displayed (and not hidden by the operating system), follow 
these steps: 
 

1. Open Windows Explorer 
2. Select ‘Folder Options’ from the ‘Tools’ menu 
3. Select the ‘View’ tab 
4. Ensure that ‘Show Hidden Files and Folders’ is selected 
5. Press the ‘OK’ button. 

 

 
Figure 6-7 – Choose a .vdr File 

 
 

6.3.1 Unarchive Extracted Data 
Data for playback can also be chosen from a previously extracted data archive.  If a portion of 
data has been previously extracted and archived it can be opened for playback via the File > 
Unarchive Extracted Data file menu option. 
 

 
Figure 6-8 – Unarchive Extracted Data 
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To playback the archived data after selecting the “Unarchive Extracted Data” file menu option, a 
user will have to locate the .rfa (archive) file and select a folder to which the data can be 



extracted.  Once extracted, an applicable configuration file will need to be selected in order to 
continue playback. 
 
 

6.4 Enabling Ethernet Broadcasts 
To enable the Playback software and Client PC to broadcast data across a network for use with a 
separate Electronic Charting System (ECS) or software, open the ‘Output’ menu dropdown and 
select “Enable Ethernet Broadcast”. If a check appears adjacent to this option, broadcasting is 
currently enabled. To disable this option, ensure no check sign appears adjacent to it. 
 

 
Figure 6-9 – Enabling Ethernet Broadcasting 

 
The broadcast will occur on UDP Port 4450 and 4451. Refer to the relevant ECS manual to 
properly enable a PC to receive an Ethernet broadcast from Rutter Technologies’ Playback 
software. 
 
 

6.5 Starting the Playback 
To start the data playback, complete the following steps: 
 

1. After a set of download data has been selected for playback, choose ‘Start’ from the 
‘Playback’ menu or press the ‘Play’ button located on the ‘Controls’ toolbar 
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Stop 
Pause Fast Forward Fast Forward Rate Play 

Playback Data Rewind Time 

Open 

Figure 6-10 – Controls Toolbar 

 
 

2. A dialog box will appear asking for a password. The default password is “VDR”. The 
password is case sensitive. It must be typed in the text box and the ‘OK’ button clicked 

3. After entering the correct password and clicking the ‘OK’ button, a second dialog box will 
appear, asking for a start time. Use the scroll bar (or enter a time in the text boxes) to 
select a playback start time. Click ‘OK’ to begin the playback. 

 



 

Start Time Scrollbar 

Figure 6-11 – Choose Start Time For Playback 

 
 

6.6 Passwords 
There are 2 passwords required to run the playback software. 
 
The first is necessary to run the playback. It is supplied with the software and can be changed by 
choosing ‘Set Password’ from the ‘Playback’ file menu. A dialog box will appear asking for the old 
and new passwords. 
 
The second password is for playback of audio data. It can be changed by choosing ‘Set 
Password’ from the ‘Audio’ file menu. All default passwords are “VDR” (case sensitive). 
 
 
 
 

 
Figure 6-12 – Change Password 

 
 

6.7 Playback Controls 
The playback can be controlled via ‘Playback’ menu items or by using the buttons located on the 
Controls toolbar. Both options offer a full range of controls, including the ability to run the 
playback in fast time (with the additional option of choosing replay speed). Figure 6.10 – Controls 
Toolbar provides an illustration of the toolbar. If available for use, buttons will appear blue (such 
as the ‘Play’ button in the illustration). If unavailable for use, buttons will be greyed (such as the 
‘Pause’ button in the illustration). 
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While playback is stopped, the ‘Fast Forward Rate’ drop down box can be used to set the 
playback fast forward speed. 
 
 

Note! The ‘Fast Forward Rate’ drop down box cannot be manipulated once a 
playback has started. 

 
 
 
To activate the fast forward feature, press the ‘Fast Forward’ button. Return the playback to 
normal time by pressing the fast forward button a second time. 
 
Select ‘Set Playback Rate’ (Playback > Set Playback Rate) to adjust the speed of the replay 
using the ‘Playback’ menu.  A dialog box will appear requiring a time compression rate. Enter any 
integer from 2 to 24 (inclusive) in the open text box and press ‘OK’ (see Figure 6.13 – Set Fast 
Forward Rate). 
 
 

 
Figure 6-13 – Set Fast Forward Rate 

 
 
The playback can be halted with the same time index in place by pressing the pause button. 
Press the pause button a second time to continue the playback. 
 
The Controls toolbar can also be hidden by deselecting ‘Controls’ from the ‘View’ menu. By 
default it is visible therefore a check will appear adjacent to this option. Deselecting it will remove 
this check mark. 
 
 

6.8 Audio Volume & Channel Selection 
Audio data includes continuous bridge audio and radio communications. The configuration of 
audio will differ between ships but is generally arranged in two (2) to four (4) banks. 
 
Individual channels contain audio data corresponding to an area of the bridge, bridge wings, or 
radio communications. Each channel may be included in the playback individually or in 
conjunction with other channels. For example, a user may wish to play back audio data recorded 
in the centre of the bridge while turning off external microphones where wind noise may be 
present. 
 

 
VDR-100G2/G2S Data Recovery Manual  46 
RUT-UM-02-003_Rev1.9 
 



 
Figure 6-14 – Audio Interface 

To activate the audio portion of a playback, choose ‘Unlock Audio’ from the ‘Audio’ file menu (see 
Figure 6.15 – Audio Menu).  A prompt will appear requiring a password; the default password 
supplied with the VDR-100G2 is “VDR”.  Press ‘OK’ to activate the audio data and make each 
channel in the ‘Audio’ file menu selectable.   
 
Once unlocked, audio data will be available for the remainder of the time playback is open.  Audio 
can be adjusted by opening the “Audio Volume” window (see Figure 6.14 – Audio Interface) via 
the “Audio Volume” option in the Audio file menu. 
 

 
Figure 6-15 – Audio Menu 

 
There are 2 ways to activate an available audio channel individually: 
 

 Select the appropriate audio channel from the ‘Audio’ file menu, or, 
 Click the ‘Active’ checkbox below the appropriate channel once the audio has been 

unlocked. 
 It is also possible to print the audio status to the ‘Log’ Tab Screen by selecting 

‘Status’ from the ‘Audio’ file menu. 
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To silence a playback, simply uncheck each channel either on the ‘Audio’ menu or via the ‘Active’ 
checkbox. 



6.9 Conning Tab Screen 
The Conning Data Tab is the default screen upon Playback start-up. In addition to the Propulsion 
and Video Channel(s) (for example, PORT X-Band, STBD S-Band, and CCTV) information tab(s) 
found in the centre of the screen, the Conning Data Tab also contains the following information 
(all along the upper left hand side of the tab screen): 
 

 Date – Date of playback information 
 Time – Time of playback information 
 Latitude – Ship’s latitude 
 Longitude – Ship’s longitude 
 GPS Mode – Global Positioning System: SPS, DGPS (Differential GPS), PPS, RTK (Real 

Time Kinematic), FRTK (Float Real Time Kinematic), and DRM (Dead Reckoning Mode) 
 Heading – Ship’s heading 
 Autopilot – Indicates the presence or non-presence of a heading control system (On/Off) 
 COG – Ship’s Course Over Ground 
 SOG – Ship’s Speed Over Ground 
 Depth – Depth of ship 
 ROT – Ship’s Rate Of Turn 

6.9.1 Depth Graph 
The Depth Graph provides an illustration, in metres (m), of the ship’s depth. 
 

 
Figure 6-16 – Depth Graph 

6.9.2 Wind Information 
The Wind Information pane contains data regarding the wind’s True and Relative Direction (Dir) 
and Speed (Sp).  
 
A compass is also provided in order to illustrate wind direction based on ship’s heading. The red 
arrow indicates True wind direction while the green arrow indicates Relative wind direction. The 
ship graphic indicates the ship’s heading. 
 

 

Red Arrow – True Wind Direction 

Green Arrow – Relative Wind Direction 
Ship Graphic – Ship Heading 

Figure 6-17 – Wind Information 
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6.9.2.1 Propulsion Data Tab 
The Propulsion Data Tab is custom designed for each individual ship according to propulsion 
systems, bow thruster configuration and NMEA strings broadcast by bridge electronics. These 
displays are dependant upon the VDRPlayback.ini file created for a particular ship. 
 

 
Figure 6-18 – Sample Propulsion Tab 

 
 
 

6.9.2.2 Video Channel Data Tab  
Radar data is captured at 15-second intervals. If multiple radar images are available for video 
capture, capture times will be staggered but still allow for individual captures at 15-second 
intervals. 
 
There are a number of options available when viewing the radar data: 

 To display the radar data in its own window, choose Full Size Video > Video 
Channels from the ‘View’ file menu. To close this window, click the ‘x’ in the top right 
corner. 

 To move the radar image (once in its own window) in order to make a particular 
section visible without adjusting the window dimensions, click and drag by placing the 
mouse pointer over a section of the image, pressing the left mouse button and 
moving the mouse; 

 To save the radar image as a .bmp file, select the ‘File’ menu > Save > Video 
Channels. A dialogue will open allowing a save location to be chosen. 
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Figure 6-19 – MultiPilot Tab 

 
 
The images are captured directly from the radar display; therefore any radar supporting ECDIS or 
chart displays will have the ECDIS or chart image recorded. 
 
 
 

Note! If proprietary data is present in the data playback, a “Proprietary” conning tab 
may appear. This tab window will present the available proprietary data in sentence 
format. 
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6.10 AIS Playback Tab Screen 
The ‘AIS Playback’ Tab Screen displays information captured from the ship’s AIS. 
 

 
Figure 6-20 – AIS Playback Tab 

There are a number of features available within the AIS Playback tab screen that allow a user to 
better interpret the downloaded information. 
 

6.10.1 Targets 
The Targets section of the AIS Playback tab screen provides a range of information about all 
targets visible in the playback window. 
 

 Targets Tab – provides a list of all ships available within the AIS view screen.  If a 
ship’s information becomes unavailable it remains in the list but a line is drawn through 
its name (it is also added to the “Lost” tab list (see below)). 

 Activated Tab – provides the name of the ship selected by the user in the AIS view 
screen. 

 Lost Tab – provides a list of ships for which information is no longer available. 
 Dangerous Tab – provides a list of all ships that are currently on a dangerous course 

relative to the user’s ship.  
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Figure 6-21 – Targets Information Section 

 
Specific ship information is also available in the following tabs (located below the above 
mentioned tabs): 
 

 Collision Info – provides information specific to a selected ship’s navigational course. 
 Target Info – provides registered information (e.g., MMSI, IMO, etc.) specific to a 

selected ship. 
 Own Ship – provides registered and navigational information for the user’s ship 

regardless of what target is selected. 
 

6.10.2 View Settings 
The View Settings section allows a user a high level of control over the AIS playback view screen. 
 

 
Figure 6-22 – View Settings Section 

 
 Viewing Range – It is possible to increase or decrease the viewing range of the AIS 

playback view screen by pressing the “+” and “-“ buttons located in the upper right of the 
View Settings section.  Note that if using a wheel mouse the viewing range can also be 
increased/decreased by moving the wheel while the pointer is located in the view 
screen.  The viewing range is listed in nautical miles. 

 Location – The latitude and longitude of the selected target is listed. 
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 Center on Selected Target – If this checkbox is selected the view screen will center on 
the selected target. 

 Set Center Button – To set the center point of the view screen, press the “Set Center” 
button, position the mouse pointer on a location on the view screen and left-click.  This 
point will now be the center point of the view screen.  Turning on the “Center on 
Selected Target” checkbox overrides this control. 

 New View – Opens a dedicated AIS Playback window. 
 

6.10.2.1 Settings 
The “Settings” button located in the View Settings section opens an “AIS Display Settings” 
window.  The settings in this window allow the user to adjust the AIS Playback display. 
 

 
Figure 6-23 – AIS Display Settings Window 

 
 

 CPA (Closest Point of Approach) 
 TCPA (Time to Closest Point of Approach) 
 COG (Course Over Ground) 
 LOA (Length Over All) 

 

6.10.3 GuardZone 
The GuardZone section allows a user to create a guard zone in the view screen.  To create a 
guard zone press the “Create” button, place the mouse cursor in the view screen area and left-
click in the locations required to create a guard zone shape.  Double-click to complete the guard 
zone formation. 
 
The guard zone can be enabled or disabled by checking or unchecking the “Enabled” checkbox. 
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6.11 Fire Doors Tab Screen 
The Fire Doors Tab Screen displays information regarding the status of the ship’s fire doors. The 
colour of the light adjacent to the door name, dependant upon the configuration, indicates an 
active (often indicated with the colour red) or non-active (often indicated with the colour green) 
door or opening. 
 
Should the number of fire doors exceed the initial screen space, a scroll bar will become visible 
allowing a user to view all available. 
 

 
Figure 6-24 – Fire Doors Tab 

6.12 Water Doors Tab Screen 
The Water Doors Tab Screen displays information regarding the status of the ship’s water doors. 
The colour of the light adjacent to the door name, dependant upon the configuration, indicates an 
active (often indicated with the colour red) or non-active (often indicated with the colour green) 
door or opening.  Should the number of water doors exceed the initial screen space, a scroll bar 
will become visible allowing a user to view all available. 
 

 
Figure 6-25 – Water Doors Tab 
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6.13 Hull Openings Tab Screen 
The Hull Openings Tab Screen displays information regarding the status of the ship’s hull 
openings. The colour of the light adjacent to the door name, dependant upon the configuration, 
indicates an active (often indicated with the colour red) or non-active (often indicated with the 
colour green) door or opening. 
 
Should the number of hull openings exceed the initial screen space, a scroll bar will become 
visible allowing a user to view all available. 
 

 
Figure 6-26 – Hull Openings Tab 

6.14 Log Tab Screen 
The ‘Log’ Tab Screen displays the size of each type of data block and the time it was recorded. 
When viewed in compressed time (fast forward), the size of data blocks written at each time-
period is displayed, but the actual NMEA strings are not. When played back in normal time, the 
‘Log’ Tab Screen will also display the NMEA strings.  ‘Log’ information can be controlled via the 
Controls toolbar. To scroll illustrated information, press the ‘Pause’ button on the Controls toolbar 
and use the ‘Log’ scrollbar to navigate. 
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Figure 6-27 – Log Window 



 

6.15 Alarms Tab Screen 
An alarm is an “on” event, only displaying when triggered. When an alarm occurs, the word 
“ALARM” will display in the lower left corner of the Playback interface. The Alarms tab allows a 
user to view information pertaining to all triggered alarms. 
 

6.16 Data Extraction 
The volume of data contained in downloaded VDR data sets can be very large.  In many 
instances it may be desirable to access smaller portions of the data without downloading the 
entire data set.  As a result it is possible to copy only a specific portion of a data set, which can 
then be easily removed to a separate location for analysis or e-mailed to a third party. 
 

6.16.1 Open Extraction Window 
To extract a specific portion of data, begin the playback of captured data.   Once data is in active 
playback mode allow it to play until the beginning point of the portion desired for extraction is 
reached: 
 

1. Select “Data Extraction” option from the “Data” file menu. 
 

 
Figure 6-28 – Data Extraction Option 

 
2. The Data Extraction window will open (see Figure 6.29 – Data Extraction Window below).  

This may take a number of seconds.  The start time will automatically appear as the point 
in the playback where the Data Extraction window was opened. 

 

 
Figure 6-29 – Data Extraction Window 
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6.16.2 Selecting Data for Extraction 
With the Data Extraction window open it is now necessary to select a segment of data to extract 
and an extraction destination. 
 

1. 3 data stream options (Video, Audio, and NMEA) are available for download.  Check the 
adjacent checkbox to select the desired data stream.  If no data stream is selected the 
Start and Stop scroll bars will not be available. 

2. When the “Video” checkbox is selected additional options will appear (may take a number 
of seconds).  The user will have the option to download individual Video channels as 
required (if available).  There is also an option to select one (1) to four (4) video image(s) 
per minute; selecting “1” allows a user to reduce the size of the Video data extraction 
(one (1) image capture per minute). 

 

 
Figure 6-30 – Data Stream Options w/ Video Selected 

 
3. Select a destination directory by clicking the word “Destination” (or, alternately, choosing 

“Choose Destination Dir” from the “Data” file menu).  Note that the destination directory 
cannot be the same as the source directory and cannot contain any other files. 

4. Select a Start and Stop time for the extracted segment.  As mentioned above, the Start 
time automatically appears as the time when the Data Extraction window was opened.  
However, this can be changed.  To adjust either the Start or Stop time, move the 
applicable scroll bar.  The file size of the extracted segment will appear to the right of the 
Stop scroll bar.  This is particularly useful, for example, when attempting to extract a 
segment to copy to a recordable Compact Disc. 

5. To create an archived file of the extracted data at the same time as the extracted data is 
being copied to the selected destination folder, select the “Archive Extracted Data” 
checkbox. 

6. To start the data extraction, press the “Start” button located in the lower right of the Data 
Extraction window or choose the “Extract” option in the “Data” file menu (Data > Extract). 

7. A progress bar will appear at the bottom of the window to indicate the progress of the 
extraction. 

8. Once completed, the Data Extraction window can be closed via the “Exit” option in the 
“File” menu (File > Exit). 

6.17 Closing the Application 
The application cannot be closed while a voyage playback is running. To close: 
 

1. Stop the playback by selecting ‘Stop’ from the ‘Playback’ menu, or by pressing the ‘Stop’ 
button in the Controls toolbar. 

2. Press the ‘Close’ (x) button in the upper right hand corner of the application’s main 
window, or choose ‘Exit’ from the ‘File’ menu.
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Appendix A – Incident Data Recovery Checklist 
 
This checklist is provided as a guideline of steps to be carried out by the incident investigation 
team in the process of recovering a FRM unit. This checklist is meant only as a guideline and 
may not represent all of the steps necessary in an incident investigation. 
 
Checklist: 
 

   Recover FRM/SFRM from incident site. 
 

   Inspect the unit for damage. 
 

   Contact the OEM with details of the damage incurred by the unit. Contact information is 
provided in Appendix C – Contact Information. 

 
   Contact the Rutter Technologies Inc. and provide all available information about the 

vessel and FRM/SFRM unit in question in order to receive the necessary files for data 
download, playback, and interpretation (contact information is provided in Appendix C – 
Contact Information). 

 
   Download data from the FRM/SFRM using methods outlined in this document. 

 
 Playback data using methods outlined in this document. 
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Appendix B – Software Download (FTP) 
 
Rutter Technologies may require, from time-to-time, approved technicians to download updated 
software via a Rutter FTP site.  Access to this site will require a Rutter Technologies provided 
password. 
 
The following instructions are provided as a step-by-step procedure for downloading software via 
this FTP site: 
 

1. Open an Internet browser, enter the following address: ftp://www.ruttertech.com in 
the “Address” field, and press “Enter”. 

2. When prompted, enter a Rutter Technologies provided User Name and Password 
combination.  Note that both User Name and Password are case sensitive. 

3. To download, right-click the applicable file and select “Copy” from the pop-up list. 
4. Select a location on the PC’s local hard drive where the file should be downloaded, 

right-click in this space, and select “Paste” from the pop-up list. 

  

ftp://www.ruttertech.com/
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Appendix C – Contact Information 
 
IMPORTANT – READ ME FIRST! 
 
Depending upon the severity and other extenuating circumstances of an incident, some 
investigative teams may opt to hand deliver the Final Recording Medium (FRM) or Simplified 
Final Recording Medium (SFRM) directly to the Original Equipment Manufacturer (OEM) 
personally. Please contact the OEM directly at the address and contact numbers listed on the 
following page to make this arrangement. 
 
Shipping labels are provided for the FRM/SFRM manufacturer that Rutter Technologies 
Incorporated currently uses and supports with the Voyage Data Recorder VDR-100G2. A 
member of the investigating team should first determine whether the FRM/SFRM is damaged in 
such a way that the normal procedure for data download or retrieval is not an option, causing the 
unit to need repair and/or refurbishment before data can be successfully downloaded or retrieved. 
 
The provided shipping labels should be used if the investigative team determines that the 
FRM/SFRM is damaged and should be sent back to the OEM. 
 
 
NOTE TO INVESTIGATORS! BE SURE TO INCLUDE A RETURN ADDRESS OR SHIPPING 
LABEL FOR THE RETURN OF FRM. 

  



Contact Information for L-3 Communications Aviation 
Recorders: 
 
If unit is to be shipped back to L-3, please contact L-3 directly and obtain Return Merchandise 
Authorization (RMA). Clearly print this RMA on the shipping label in space provided and route 
shipment through L-3’s Customs Agent in Tampa, Florida, USA. 
 
L-3 Communications Custom Agents: 
Tampa International Airport 
Air Cargo Building 
4700 North Hoover Blvd. 
Tampa, Florida 33634 USA 
Telephone: (813) 273 0975 
Facsimile: (813) 875 5809  
 
L-3 Shipping Address: 
L-3 Communications 
Attn: Repair Department 
6000 East Fruitville Road 
Sarasota, Florida 34232 USA 
Telephone: (941) 371 0811 
Facsimile: (941) 377 5591 
Web: http://www.l-3ar.com/ 
 
 
Contact Information for Jotron Electronics: 
 
If unit is to be shipped back to Jotron, please contact Jotron directly and obtain Return 
Merchandise Authorization (RMA). Clearly print this RMA on the shipping label in space provided. 
 
Jotron Electronics s.a. 
P.O. Box 54 
NO-3280 Tjodalyng, Norway 
Telephone: +47 33 13 97 00 
Facsimile: +47 33 12 67 80 
Web: http://www.jotron.com 
 
 
 
Contact Information for Rutter Technologies Inc.: 

 
Rutter Technologies Inc. 
70 Brookfield Road 
St. John’s, Newfoundland 
Canada A1E 3T9 
 
Telephone: +1 709 368 4213 (available on a 24-hour basis) 
Facsimile: +1 709 368 1337 
 
Web: http://www.ruttertech.com 

  



L-3 Communications Shipping Labels: 
 
Included on the following two pages. 
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SHIP TO: 
 

L-3 Communications 
Attention: Repair Department 
6000 East Fruitville Road, 

Sarasota, Florida 34232 USA 
 

Telephone: (941) 371 0811 
 

 

RMA# _________________________ 
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SHIP TO: 

 
L-3 Communications 

Attention: Repair Department 
6000 East Fruitville Road, 

Sarasota, Florida 34232 USA 
 

Telephone: (941) 371 0811 
 

 

RMA# _________________________ 
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Jotron Electronics Shipping Labels: 
 
Included on the following two pages. 
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SHIP TO: 
 

Jotron Electronics s.a. 
P.O. Box 54 

NO-3280 Tjodalyng, Norway 
 

Telephone: +47 33 13 97 00 
 

 
 
 

RMA# _________________________
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SHIP TO: 
 

Jotron Electronics s.a. 
P.O. Box 54 

NO-3280 Tjodalyng, Norway 
 

Telephone: +47 33 13 97 00 
 

 
 
 

RMA# _________________________
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Appendix D – IMO Guideline Document 
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